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1.  CREATE AND APPLY STYLES IN THE DOCUMENT 

A style is a set of formats that you can apply to selected pages, text, frames, and other 

elements in your document to quickly change their appearance. When you apply a style, 

you apply a whole group of formats at the same time. 

Styles are logical attributes. Using styles means that you stop saying “font size 14pt, 

Times New Roman, bold, centered”, and you start saying “Title” because you have defined 

the “Title” style to have those characteristics. In other words, styles mean that you shift the 

emphasis from what the text (or page, or other element) looks like, to what the text is. 

Styles help improve consistency in a document. They also make major formatting changes 

easy. For example, you may decide to change the indentation of all paragraphs, or change 

the font of all titles. For a long document, this simple task can be prohibitive. Styles make 

the task easy. 

OpenOffice.org supports the following types of styles: 



 

• Page styles include margins, headers and footers, borders and backgrounds. In 

Calc, page styles also include the sequence for printing sheets. 

• Paragraph styles control all aspects of a paragraph’s appearance, such as text 

alignment, tab stops, line spacing, and borders, and can include character 

formatting. 

• Character styles affect selected text within a paragraph, such as the font and size 

of text, or bold and italic formats. 

• Frame styles are used to format graphic and text frames, including wrapping type, 

borders, backgrounds, and columns. 

• Numbering styles apply similar alignment, numbering or bullet characters, and fonts 

to numbered or bulleted lists. 

• Cell styles include fonts, alignment, borders, background, number formats (for 

example, currency, date, number), and cell protection. 

• Graphics styles in drawings and presentations include line, area, shadowing, 

transparency, font, connectors, dimensioning, and other attributes. 

• Presentation styles include attributes for font, indents, spacing, alignment, and 

tabs. 

Applying styles 

OpenOffice.org provides several ways for you to select styles to apply. 

 Using the Styles and Formatting window 

1) Click the Styles and Formatting icon located at the left-hand end of the object 

bar, or click Format > Styles and Formatting, or press F11. The Styles and 

Formatting window shows the types of styles available for the OOo 

(OpenOffice.org) component you are using. Figure 1 shows the window for Writer, 

with Page Styles visible. 

You can move this window to a convenient position on the screen or dock it to an 

edge (hold down the Ctrl key and drag it by the title bar to where you want it 

docked). 

2) Click on one of the icons at the top left of the Styles and Formatting window to 

display a list of styles in a particular category. 

3) To apply an existing style (except for character styles), position the insertion point 

in the paragraph, frame, or page, and then double-click on the name of the style in 

one of these lists. To apply a character style, select the characters first. 



 

Tip 

At the bottom of the Styles and Formatting window is a dropdown list. In 

Figure 1 the window shows Automatic, meaning the list includes only 

styles applied automatically by OOo(OpenOffice.org). You can choose 

to show all styles or other groups of styles, for example only custom 

styles. 

 

 

 Using Fill Format mode 

Fill format mode is used to apply a style to many different areas quickly without 

having to go back to the Styles and Formatting window and double-click every time. 

This method is quite useful when you need to format many scattered paragraphs, 

cells, or other items with the same style. 

1) Open the Styles and Formatting window and select the style you want to 
apply. 

2) Click the Fill Format mode icon . 

3) To apply a paragraph, page, or frame style, hover the mouse over the 
paragraph, page, or frame and click. To apply a character style, hold down the 
mouse button while selecting the characters, clicking on a word applies the 
character style for that word. Repeat step 3 until you made all the changes for 
that style. 

4) To quit Fill Format mode, click the Fill Format mode icon again or press the 
Esc key. 

Caution 

 

When this mode is active, a right-click anywhere in the document 

undoes the last Fill Format action. Be careful not to accidentally right-

click and thus undo actions you want to keep. 

 
Figure 1: The Styles and Formatting window for Writer, showing paragraph styles 



 

Creating new (custom) styles 

You may want to add some new styles. You can do this in two ways: 

 Creating a new style from a selection 

You can create a new style by copying an existing manual format. This new style 
applies only to this document; it will not be saved in the template. 

1. Open the Styles and Formatting window and choose the type of style you 
want to create. 

2. In the document, select the item you want to save as a style. 

3. In the Styles and Formatting window, click on the New Style from Selection 
icon (refer Figure 2). 

4.  

5. In the Create Style dialog, type a name for the new style. The list shows the 
names of existing custom styles of the selected type. Click OK to save the new 

style. 

 

 Dragging and dropping to create a style 

You can drag and drop a text selection into the Styles and Formatting window to create 
a new style. 

Select some text and drag it to the Styles and Formatting window. If Paragraph Styles 
are active, the paragraph style will be added to the list. If Character Styles are active, 
the character style will be added to the list. 

Modifying styles 

OpenOffice.org provides several ways to modify styles (both the predefined styles and 
custom styles that you create): 

• Updating a style from a selection 

• Load or copy styles from another document or template 

 
Figure 2: Naming a new style created from a selection 



 

Tip 
Any changes you make to a style are effective only in the current 
document. To change styles in more than one document, you need to 
change the template or copy the styles into the other documents. 

 

 Updating a style from a selection 

To update a style from a selection: 

1. Open the Styles and Formatting window. 

2. In the document, select an item that has the format you want to adopt as a 
style. 

Caution 

 

Make sure that there are unique properties in this paragraph. For 
example, if there are two different font sizes or font styles, that 
particular property will remain the same as before. 

3. In the Styles and Formatting window, select the style you want to update 
(single-click, not double-click), then long-click on the arrow next to the New 
Style from Selection icon and click on Update Style(Refer Figure 3). 

 

 Loading styles from a template or document 

You can copy styles by loading them from a template or another document: 

1. Open the document you want to copy styles into. 

2. In the Styles and Formatting window, long-click on the arrow next to the New 
Style from Selection icon, and then click on Load Styles. 

3. On the Load Styles dialog (Figure 4), find and select the template you want 
to copy styles from. 

Figure 3: Updating a style from a selection 



 

 
 

4. Select the categories of styles to be copied. Select Overwrite if you want the 
styles being copied to replace any styles of the same names in the document 
you are copying them into. 

5. Click OK to copy the styles. You will not see any change on screen. 

Note 
To copy the styles from another document, click the From File button 

to open a window from which you can select the required document. 

Caution 

 

If your document has a table of contents, and if you have used custom 
styles for headings, the heading levels associated with outline levels (in 
Tools > Outline Numbering) will revert to the defaults of Heading 1, 
Heading 2, and so on when you load styles this way. You will need to 
change these back to your custom heading styles. This is a bug. 

 

 

 

 

 

 
Figure 4. Copying styles from a template into the open document 



 

 

2. INSERT AND USE IMAGES 

Images can be added to a document in several ways: by inserting an image file, directly 
from a graphics program or a scanner, or from the OOo Gallery. 

Inserting an image file 

When the image is in a file stored on the computer, you can insert it into an OOo 
document using either of the following methods: 

 Drag and drop 

1. Open a file browser window and locate the image you want to insert. 

2. Drag the image into the Writer document and drop it where you want it to 
appear. A faint vertical line marks where the image will be dropped. 

This method embeds (saves a copy of) the image file in the Writer document. To link 
the file instead of embedding it, hold down the Control+Shift keys while dragging the 
image. 

 Insert Picture dialog 

1. Click in the OOo document where you want the image to appear. 

2. Choose Insert > Picture > From File from the menu bar. 

3. On the Insert Picture dialog (see Figure 5), navigate to the file to be inserted, 
select it, and click Open. 

At the bottom of the dialog are two options, Preview and Link. Select Preview to 
view a thumbnail of the selected image on the right, so you can verify that you have 
the correct file. See below for the use of Link. 



 

 

 Inserting an image from the clipboard 

Using the clipboard, you can copy images into an OOo document from another OOo 
document and from other programs. To do this: 

1. Open both the source document and the target document. 

2. In the source document, select the image to be copied. 

3. Move the mouse pointer over the selected image and press Control+C to copy 
the image to the clipboard. 

4. Switch to the target document. 

5. Click to place the cursor where the graphic is to be inserted. 

6. Press Control+Vto insert the image. 

Caution 

 

If the application from which the graphic was copied is closed before the 
graphic is pasted into the target, the image stored on the clipboard could 
be lost. 

 Inserting an image using a scanner 

If a scanner is connected to your computer, OOo can call the scanning application and 
inserted the scanned item into the OOo document as an image. To start this 
procedure, click where you want the graphic to be inserted and select Insert > Picture 
> Scan > Select Source. 

Although this practice is quick and easy, it is unlikely to result in a high-quality image of 
the correct size. You may get better results by scanned material into a graphics 
program and cleaning it up there before inserting the resulting image into OOo. 

 
Figure 5. Insert picture dialog 



 

 Inserting an image from the Gallery 

The Gallery provides a convenient way to group reusable objects such as graphics and 
sounds that you can insert into your documents. The Gallery is available in all 
components of OOo. It does not come with many graphics, but you can add your own 
pictures or find extensions containing more graphics. To insert a Gallery image into a 
Writer document: 

1. To open the Gallery, click on the Gallery icon (located in the right side of 
the Standard toolbar) or choose Tools > Gallery from the menu bar. 

2. Navigate through the Gallery to find the desired picture. 

3. To insert the picture, click and drag it from the Gallery into the Writer 
document. You can also right-click on the picture and choose Insert>Copy. 

Figure 6 shows an example of an image dragged from the Gallery. 

 

By default, the Gallery is docked above the Writer workspace. To expand the 
Gallery, position the pointer over the line that divides it from the top of the 
workspace. When the pointer changes to parallel lines with arrows, click and drag 
downward. The workspace resizes in response. 

To expand the Gallery without affecting the workspace, undock it so it floats over 
the workspace. To do so, hold down the Control key and double-click on the upper 
part of the Gallery next to the View icons.  Double-click in the same area while 
holding down the Control key to dock it again (restore it to its position over the 
workspace). 

 
Figure 6. Inserting an image from the Gallery 



 

When the Gallery is docked, to hide it and view the full Writer workspace, click the  
in the middle of the thin bar separating the Gallery from the workspace. 

To close the Gallery, choose Tools > Gallery to uncheck the Gallery entry, or click 
on the Gallery icon again. 

Modifying an image 

When you insert a new image, you may need to modify it to suit the document. Here we 
will discuss the use of the Picture toolbar, resizing, cropping, and a workaround to rotate a 
picture. 

 Using the Picture toolbar 

When you insert an image or select one already present in the document, the Picture 
toolbar appears. You can set it to always be present (View > Toolbars > Picture). 
Picture control buttons from the Picture toolbar can also be added to the Standard 
Toolbar.  

Two other toolbars can be opened from this one: the Graphic Filter toolbar, which can 
be torn off and placed elsewhere on the window, and the Color toolbar, which opens as 
a separate floating toolbar. 

From these three toolbars, you can apply small corrections to the graphic or obtain 
special effects. 

Graphics mode  

You can change color images to grayscale by selecting the image and then selecting 
Grayscale from the Graphics mode list. 

Flip vertically or horizontally  

To flip an image vertically or horizontally, select the image, and then click the relevant 
icon. 

Filters 

Table 1 provides a short description of the available filters, however the best way to 
understand them is to see them in action. Feel free to experiment with the different 
filters and filters settings, remembering that you can undo all the changes by pressing 
Ctrl+Z or Alt+Backspace or by selecting Edit > Undo. 

Color 

Use this toolbar to modify the individual RGB color components of the image (red, 
green, blue) as well as the brightness, contrast, and gamma of the image. If the result 
is not satisfactory, you can press Control+Z to restore the default values. 

Table 1: Graphic filters and their effects 

Icon Name Effect 

 Invert 
Inverts the color values of a color image or the 
brightness values of a grayscale image. 



 

Icon Name Effect 

 
Smooth Softens the contrast of an image. 

 Sharpen Increases the contrast of an image. 

 
Remove noise Removes single pixels from an image. 

 Solarization 
Mimics the effects of too much light in a picture. A further 
dialog box opens to adjust the parameters. 

 Aging 

Simulates the effects of time on a picture. Can be applied 
several times. A further dialog box opens to adjust the 
aging level. 

 Posterize 
Makes a picture appear like a painting by reducing the 
number of colors used. 

 
Pop Art Modifies the picture dramatically. 

 Charcoal Displays the image as a charcoal sketch. 

 
Relief 

A dialog box is displayed to adjust the light source that 
will create the shadow and, hence, the relief effect. 

 Mosaic Joins groups of pixels into a single area of one color. 

Transparency  

Modify the percentage value in the Transparency box on the Picture toolbar to 
make the image more transparent. This is particularly useful when creating a 
watermark or when wrapping the image in the background. 

 Using the formatting toolbar and Picture dialog 

When an image is selected, you can customize some aspects of its appearance using 
the tools available on the Formatting toolbar as well as in the dialog that is shown by 
right-clicking on the image and selecting Picture. You can, for example, create a 
border around the image, selecting style and color; or you can (in the Borders page of 
the Picture dialog) add a shadow to the image. 

 Cropping images 

When you are only interested in a section of the image for the purpose of your 
document, you may wish to crop (cut off) parts of it. To start cropping the image, right-
click on it and select Picture from the pop-up menu. In the Picture dialog box, select 
the Crop page (see Figure 7). 



 

 

In the Crop page, you can control the following parameters: 

 Keep scale / Keep image size 
When Keep scale is selected (default), cropping the image does not change the 
scale of the picture. 

When Keep image size is selected, cropping produces enlargement (for 
positive cropping values), shrinking (for negative cropping values), or distortion 
of the image so that the image size remains constant. 

 Left, Right, Top, and Bottom 

The image is cropped by the amount entered in these boxes. For example, a 
value of 3cm in the Left box cuts 3 cm from the left side of the picture. 

• When Keep scale is selected, the size of the image also changes, so in this 
example the width will be reduced by 3 cm. 

• When Keep image size is selected, the remaining part of the image is 
enlarged (when you enter positive values for cropping) or shrunk (when you 
enter negative values for cropping) so that the width and height of the image 
remains unchanged. 

 Width and Height 

The Width and Height fields under either Scale or Image size change as you 
enter values in the Left, Right, Top, and Bottom fields. Use the thumbnail next to 
these fields to determine the correct amount by which to crop. 

 Resizing an image 

The inserted image might not fit perfectly into the document if it is too big or too small. In 
these cases, you can use Writer to resize the image. 

1. Click the picture, if necessary, to show the green resizing handles. 

2. Position the pointer over one of the green resizing handles. The pointer 
changes shape giving a graphical representation of the direction of the resizing. 

Figure 7: The options available when cropping a picture 



 

3. Click and drag to resize the picture. 

4. Release the mouse button when satisfied with the new size. 

The corner handles resize both the width and the height of the graphic object 
simultaneously, while the other four handles only resize one dimension at a time. 

Tip 
To retain the original proportions of the graphic, Shift+click one of the 
corner handles, then drag. Be sure to release the mouse button before 
releasing the Shift key. 

Be aware that re-sizing a bit-mapped (raster) image will adversely affect the resolution, 
causing some degree of blurring. It is better to externally size your picture correctly before 
insertion into your presentation, if possible. 

Figure 8 shows three examples of an image inserted into a document and resized. 

 

For more accurate resizing, use either the Crop page of the Picture dialog box (Figure 7) 
or, for images, the Type page of the Picture dialog box. On the Crop page you can adjust 

the following settings: 

 Scale Width and Height: specify in percentages the scaling of the picture. The size 

of the image changes accordingly. For a scaled resizing, both values should be 
identical. 

• Image size: specify the size of the image in your preferred unit of measurement. 
The image enlarges or shrinks accordingly. 

• Original size button: when clicked, restores the image to its original size. 

 
Figure 8. Three examples of resized images, plus the original image 



 

In the Type page of the Picture dialog box, select the Relative option to toggle between 
percentage and actual dimension. For a scaled resizing, select the Keep ratio option. As 
for the Crop page, clicking on the Original Size button restores the original image size. 

 Rotating a picture 

Writer does not provide a tool for rotating a picture; however, there is a simple 
workaround: 

1. Open a new Draw or Impress document (File > New > Drawing or File > New > 
Presentation). 

2. Insert the image you want to rotate. You can use any of the mechanisms 
described in “Error! Reference source not found.” on page Error! Bookmark 
not defined., although there are some slight variations in the position of the 
menu entries and icons. 

3. Select the image, then in the Drawing toolbar (shown by default at the bottom of 

the window in Impress and Draw), select the Rotate icon from the Effects 

tear-off toolbar . 

4. Rotate the image as desired. Use the red handles at the corners of the picture 
and move the mouse in the direction you wish to rotate. By default the picture 
rotates around its center (indicated by a black crosshair), but you can change the 
pivot point by moving the black crosshair to the desired rotation center. 

Tip 
To restrict the rotation angle to multiples of 15 degrees keep the Shift key 
pressed while rotating the image. 

5. Select the rotated picture by pressing Ctrl+A, then copy the image to the 
clipboard with Ctrl+C. 

6. Finish by going back to the location of the Writer document where the image is to 
be inserted and pressing Ctrl+V. 

 

Creating drawing objects 

To begin using the drawing tools, display the Drawing toolbar (Figure 9), by clicking View 
> Toolbars > Drawing. 

 

 

1 Select 5 Freeform Line 9 Symbol Shapes 13 Stars 
2 Line 6 Text 10 Block arrows 14 Points 
3 Rectangle 7 Callouts 11 Flowcharts 15 Font work Gallery 
4 Ellipse 8 Basic Shapes 12 Callouts 16 From File 
      17 Extrusion On/Off 



 

Figure 9. The Drawing toolbar 

 

To use a drawing tool: 

1. Click in the document where you want the drawing to be anchored. You can 
change the anchor later, if necessary. 

2. Select the tool from the Drawing toolbar (Figure 7). The mouse pointer changes 

to a drawing-functions pointer . 

3. Move the cross-hair pointer to the place in the document where you want the 
graphic to appear and then click-and-drag to create the drawing object. Release 
the mouse button. The selected drawing function remains active, so you can draw 
another object of the same type. 
 

4. To cancel the selected drawing function, press the Esc key or click on the Select 
icon (the arrow) on the Drawing toolbar. 

 

5. You can now change the properties (fill color, line type and weight, anchoring, and 
others) of the drawing object using either the Drawing Object Properties toolbar or 
the choices and dialog boxes reached by right-clicking on the drawing object. 

 

Set or change properties for drawing objects 

 

To set the properties for a drawing object before you draw it: 

1. On the Drawing toolbar (Figure 9), click the Select tool. 

2. On the Drawing Object Properties toolbar (Figure 10), click on the icon for each 
property and select the value you want for that property. 

3. For more control, or to define new attributes, you can click on the Area or Line 
icons on the toolbar to display detailed dialog boxes. 

The default you set applies to the current document and session. It is not retained when 

you close the document or close Writer, and it does not apply to any other document you 

open. The defaults apply to all the drawing objects except text objects. 

  



 

 

 

1 Line 5 Line Color 9 To Foreground 13 Alignment 

2 Arrow Style 6 Area 10 To Background 14 Change Anchor 

3 Line Style 7 Area Style / Filling 11 Bring to Front 15 Ungroup 

4 Line Width 8 Rotate 12 Send to Back 16 Group 

Figure 10. Drawing Object Properties toolbar 

 

To change the properties for an existing drawing object: 

1. Select the object. 

2. Continue as described above. 

You can also specify the position and size, rotation, and slant and corner radius properties 
of the drawing object: 

1. Right-click on the drawing object and then click Position and Size from the pop-up 
menu. The Position and Size dialog box is displayed. 

2. Choose any properties, as required. 

 

Resizing a drawing object 

The same considerations for resizing an image apply also to resizing an object. Select the 
object, click on one of the eight handles around it and drag it to its new position. For a 
scaled resizing, select one of the corner handles and keep the Shift key pressed while 
dragging the handle to its new position. 

For more sophisticated control of the size of the object, select Format > Object > 
Position and Size from the menu bar. Use the Position and Size dialog box to set the 
width and height independently. If the Keep ratio option is selected, then the two 
dimensions change so that the proportion is maintained, allowing for a scaled resizing. 
 

Grouping drawing objects 

To group drawing objects: 

1. Select one object, then hold down the Shift key and select the others you want to 
include in the group. The bounding box expands to include all the selected objects. 

2. With the objects selected, hover the mouse pointer over one of the objects and 
choose Format > Group > Group from the menu bar or right-click and choose 
Group > Group from the pop-up menu. 

Note 
You cannot include an embedded or linked graphic in a group with 
drawing objects. 



 

 

Positioning image/graphics within the text 

When you add a graphic to a text document, you need to choose how to position it with 

respect to the text and other graphics. The positioning of graphics is often rather time-

consuming and may be very frustrating for both inexperienced and experienced users. As 

Writer is a word processor rather than a desktop publishing program, there are some 

limitations to the flexibility in positioning images and it takes time to get things exactly as 

you would like them. 

Positioning of a graphic is controlled by four settings: 

1. Arrangement refers to the placement of a graphic on an imaginary vertical axis. 
Arrangement controls how graphics are stacked upon each other or relative to the 
text. 

2. Alignment refers to the vertical or horizontal placement of a graphic in relation to 
the chosen anchor point. 

3. Anchoring refers to the reference point for the graphics. This point could be the 
page, or frame where the object is, a paragraph, or even a character. An image 
always has an anchor point. 

4. Text wrapping refers to the relation of graphics to the surrounding text, which may 
wrap around the graphic on one or both sides, be overprinted behind or in front of 
the graphic, or treat the graphic as a separate paragraph or character. 

The settings can be accessed in a number of ways, depending on the nature of the 
graphics: 

1. From the Format menu, where you can find Alignment, Arrange, Wrap, and 
Anchor (both for images and drawing objects). 

2. From the pop-up menu displayed when you right-click on the graphic. 

3. From the Object toolbar shown in Figure 11. 

4. For images, from the Type and Wrapping pages of the Picture dialog box. Note 
that you cannot control the arrangement using the dialog box. To open the Picture 
dialog box, click on the image to select it and then choose Format > Picture or 
right-click on the graphic and choose Picture on the pop-up menu. 

5. For drawing objects, from the Position and Size page of the Position and Size 
dialog box. To open the Position and Size dialog box, click on the drawing object 
to select it and then choose Format > Object > Position and Size or right-click 
on the graphic and choose Position and Size on the pop-up menu. Note that you 

can only control the alignment and anchoring. 

 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1 Apply Style 6 Center Horiz. 11 Borders 16 Bring to Front 

2 Wrap Off 7 Align Right 12 Line Style 17 Send to Back 

3 Page Wrap 8 Top 13 Line Color (of border) 18 Change Anchor 

4 Wrap Through 9 Center 14 Background Color 19 Link Frames 

5 Align Left 10 Bottom 15 Frame Properties 20 Unlink Frames 

Figure 11. Object toolbar (graphical control of positioning for images) 



 

 

Working with tables in Open Office Writer 

A table is a grid, an arrangement of rectangles, or cells, in rows and column. You can use 

tables to format all or part of your document into columns and rows. You need tables 

because they are the best way to organize graphics, columns, headings and rows. 

 

Column- 

A column is a grouping of cells that run from the top to the bottom of a page. 

 

Rows- 

Row is a grouping of cells that run from the left to right of a page. 

 

Cell- 

The intersection point between a row and a column is a cell. 

 

Inserting a Table 

1. Position the insertion point where you want the table to appear. 

2. Choose Table ->Insert ->Table option. This will display the Insert Table   

dialog box. 

 

 

3. Enter the number of rows and columns for the table in the number of columns  

and the number of row boxes. 



 

Auto fit option in Table menu 

1. Fixed Column width - You can set a precise width to be used by all the columns      in 

your table by clicking in the fixed column width scroll box and entering the value there. 

2. Auto Fit to Contents- You can choose Auto fit to contents, which enables word to 

widen columns based on the contents you insert in them i.e. Word adjusts the columns as 

you type within the cells. 

3. Auto Fit to window- You can choose Auto fit to window, which adjusts the width of 

every cell based on the width of the screen of the individual viewing it. For example, if you 

change your monitor for displaying at 640*480 to 800*600, your cells widen. This feature 

works only with documents saved as Web Pages and viewed from within Word or a Web 

Browser. 

Entering Text into a table 

To enter text into a table, simply type as you normally would after placing the insertion 

point in required cell. Press Tab to move to the next cell. 

 

Selecting a Row  

1. Click anywhere in the first row of your table. 

2. Choose Table>Select>Row from the menu. 

 

Adding Images to a Table 

1. Position the insertion point in any cell where you want the image to be added. 

2. Click on the Clip art to select any image from there. 

3. After selecting an image, click on Insert clip button to insert the image in that 

particular area. 

 

Inserting Rows, Columns and Cells 

To insert a Column 

1. Select the column beside where you want to insert a column, 

2. Choose Table -> Insert from the menu. 

3. Columns to the Left: Insert a column to the left of the currently selected column. 

4. Columns to the Right: Insert a column to the right of the currently selected column. 

To insert multiple columns, in step 1, select the same number of columns that you 



 

want to insert or repeat step 2 until the desired number of columns have been 

inserted.  

 

 

 

 

 

 
 

 

 

 

To insert a Row 

1. Select the row above or below where you want to insert a row. 

2. Choose Table ->Insert from the menu. 

3. Rows Above: Inserts a row above the currently selected column. 

4. Rows Below: Inserts a row below the currently selected column. 

To insert a row at the bottom of the table, position the Insertion point in the last cell of the 

table and press Tab. An empty row is inserted. 

To insert multiple rows, in step 1, select the same number of rows that you want to insert 

or repeat step 2 until the number of rows have been inserted. 

To insert a Cell 

1. Select a cell at the location where you want to 

insert a cell. 

2. Choose Table ->Insert ->Cells. 

An Insert Cells dialog box is displayed.  

Select desired option from the dialog box as 

follows: 

a) Shift cells right- Inserts a cell in the same row and moves the cells to its right.  

b) Shift cells down - Inserts a cell in the same column and moves the cells below it 

down.  

c) Insert entire row- Inserts a row above the selected cell.  

d) Insert entire column- Inserts a column to the left of the selected cell. 



 

3. Click OK button.  

To delete Rows, columns or cells 

Simply click one of the cells you want to delete, or select all the rows and columns you want to 

delete. Then, 

• To delete the column in which your insertion point is,                                   Choose Table 

>Delete >Column. 

• To delete the row in which your insertion point is, Choose Table>Delete>Rows. 

• To delete the entire table, Choose Table -->Delete-->Table. 

 

 

 

 

 

 

 

 

 

 

If you delete a cell, choose an option in the Delete Cells dialog box that is shown above.  

a) Shift Cells left- Deletes the cell and moves the cells to its right to the left.  

b) Shift Cells up- Deletes the cell and moves the cells below it up.  

c) Delete entire row- Deletes the row.  

d) Delete entire column- Deletes the column. 

Formatting Text in the cells 

a. Click on the cell, which you want to format. 

b. Select the text. 

c. Click on Format -> Font. 

Formatting images in the cells 

1. Click on the cell where you want to change the formatting of the image. 

2. Click on Format-> Format Picture. 

 

 



 

Merging of Cells 

Merging of cells means turning two or more cells 

into one cell or combining two or more cells into  

one cell. 

● To merge cells/rows/columns, first select the  

cells/rows/columns which you want to merge. 

● Click on the Table ->Merge cells. 

 

Splitting Of Cells 

Splitting of cell means to split a cell into number of cells. For this you should have a table 

already created. In order to split a cell into number of cells follow all these steps: 

 

 

 

 

 

 

 

 

 

1. Place your cursor on the cell you want to split. 

2. Click on Table ->Split cells 

3. Enter number of columns and the number of rows you want to split into. 

4. Press Enter or click on OK button. 

 

 

 

 

 

 

 

 


